“Uninstall completed. Some elements

d not be removed. Manually remove
these items.” Apparently the uninstall
not completed. WinXP may be the
est OS to ever come out of Redmond,
t it’s still plagued by the build-up of
ital crud that results from sloppy
ilousekeeping. Applications deleted long
ago leave behind remnants. Spyware

j smelly droppings throughout your
-~ system folders. File fragments, temp files,
- and obsolete driver packages clog the
 pipes. All this crap slows down perform-
 ance, extends search times, and, at worst,
 creates system instabilities.

~ WinXP utilities like Disk Cleanup and
 System Restore can be helpful in keeping
your system in good health, but the
truth is that there’s no substitute for a

~ top-to-bottom OS reinstall to make your
- PC feel like new. It's called a “clean
start,” and on the following pages, we'll
~ show you how to perform one with the

~ highest level of personal customization

- possible. We first did this project in June
- 2000 with Win98, and because the article
- was so well-received, we decided to
update it for WinXP. Our time-tested
(and improved) Maximum PC process
involves backing up all your valuable
files, wiping your system clean, rein-
stalling your OS along with all your per-
sonal settings and favorite apps, then
creating a mirror image of this perfect

Stuff you’ll need:

ﬁﬂere's a classic Windows-ism for you:

system profile on CD-ROMs. It'll include
all your OS preferences, all your network-
ing settings, and all the software you use
on a daily basis—ready to load at any
time, and ready to rescue you from disas-
ter. Here's what you’ll need:

W Windows XP installation CD
W PowerQuest Drive Image 2002
B CD-Rs or CD-RWs (at

least three)

W A CD burner

After you're done, you'll be able to
get that “fresh-out-of-the-shower” feel-
ing anytime you want just by popping
your recovery CDs and loading in your
image. System feeling groggy? Virus
attack? No problem. All you need is a
clean start.

TEN EASY
STEPS

Lest you get antsy about the sheer scope of
this project, check out how easy the process
really is. Here's a brief outline of what you'll
be doing:

1. Confirm that you can boot from CD.
Most PCs shouldn’t have a problem boot-
ing directly off of a CD, but some really

CD-Rs or CD-RWs (at least three) Windows XP installation CD

old motherboards may have issues
with this, so it's best to check.

2. Back up your data. All your files will
be wiped clean during this project. Sorry,
that’s the nature of the beast.

3. Collect the essentials. Before you reck-
lessly reformat your drive, you're going to
make sure you have all the tools required
for the project.

4. Format your drive. This is the point
of no return. Anything not backed up is
about to be offered as sacrifice to the god
of hard drives.

5. Install XP. This process is much easier
than it was in previous Windows incarna-
tions, but it's still the longest step here, so
pay attention.

6. Windows Update. Microsoft’s online
resources will help you plug security
holes and stomp out bugs.

7. Install drivers. Many people forget this
step and end up wondering why their
frame rates are in the toilet.

8. Tweak XP. Here’s the part where you
get to wring every last bit of performance
from the OS.

9. Install apps. Your PC isn’t going to be
much use without some software to run.

10. Create restore discs. Finally, we're
going to take a snapshot of your pristine,
perfectly configured system.

PowerQuest Drive Image 2002

~
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Confirming that you can
boot from CD

In order to restore your system without
requiring a fragile floppy startup disk, your
PC must be able to boot from a CD-ROM.
Fortunately, almost all PCs that meet the
minimum system requirements for WinXP
are able to boot from the optical drive. Even
s0, you're still going to have to configure
your BIOS so that your PC checks the CD-
ROM for a bootable disc before turning to
the hard drive. Here’s how to do it.

Restart your computer. As soon as the
screen that indicates your BIOS is loading
comes up, you'll have a few seconds to press
the correct key to enter the BIOS. The name
of the key should appear on the screen
(e.g.,“Press F1 to enter the BIOS”), but if it
doesn't, check your motherboard documenta-
tion. If you don't have a manual, try the
Delete key. If that doesn’t work, try pressing
each of the function keys (F1, F2, etc.) and the
Escape key until you hit the right one.

Once you enter your BIOS, check to see
whether your BIOS is from Award or AMI by
reading the title at the top. If you have an
Award BIOS, enter the Advanced BIOS
Features tab and scroll down to First Boot
Device. It should be preset to Floppy.
Because we aren'’t going to use the Floppy
drive for boot purposes, press Enter, select
CDROM from the list, and press Enter again.
Now press Escape until you're back at the
BIOS entry screen. Select “Save & Exit
Setup” from the menu, and press Enter.

If your BIOS is an AM], select the
Advanced BIOS Features tab, scroll to 1st Boot
Device, and use the plus and minus keys until
you've selected CDROM. Now press Escape,
select “Save & Exit Setup,” and press Enter.

Once you've done all this, you should be
ready to boot off a CD. If you can't seem to
get the CD to boot, see the sidebar on page
35 for alternatives.

VOK,l‘nconﬂrmedﬂlatmyPC
can boot from my CD-ROM, and I've
made the CD-ROM my first boot
device. I'm ready to move on.

STEP 2

Back up data

Virus Harning

CPU L1 & L2 Cache
Quick Power On Self Test
RAID & SCSI Boot Order
First Boot Device
Second Boot Device
Third Boot Device

Boot Other Device
Swap Floppy Drive

Boot Up Floppy Seek
Boot Up NumLock Status
Tupenatic Rate Setting

Se&uf ity Option

Advanced BI10S Features

[Disabled]
[Enabled]
[Enabled]
CRAID,SCSI]
LCDROM]
[HDD-81
[LS128]
[Enabled]
[Disabled]
[Enabled]
[On]
[Disabled]

[Setup]

0S Select For DRAM > 64MB [Non-0S2]
Report No FDD For HIN 95 ([Nol

Phoenix - RuwardBIUS CMUS Setup Utility

Menu Level »

Select Your Boot
Device Priority

STEP 1 Once you're done with the “clean start” process, you can shave a couple
seconds off your boot time by switching First Boot Device back to your floppy drive.

documents are littered far and wide, let this
be a lesson to you. Centralizing your data into
one main folder—such as My Documents—
can spare you the trouble of spelunking the
depths of your system when you need to gather
up coveted MP3s, JPGs, and AVIs.

Yes, you'll be tempted to use WinXP’s Files
and Settings Transfer Wizard. It purports to
offer one-click backup of all the data you'll
want installed on a new system. But trust us,
it’s not foolproof. The problem is that the
wizard also transports all of the gunk—

-
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+ § My Computer
+ %3 My Network Places
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Data backup can range from “quick and effort-
less” to “complete nightmare” depending on
how organized your files are. If your personal
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STEP 2 Don't miss any important files during a backup, because you can’t come

back for them after you reforma
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, and so on—along with your data
tings. This of course defeats the pur-
of performing a clean install!

Jet’s get down to business. On your

lop, create a folder that will evenrually

ny sundry files you might have created on
primary hard disk, be they text docu-
ts, videos, or MP3s—anything you want
save for posterity. Make sure you organize
e files into sub-folders, and as long as
) got the opportunity to tidy up
H ﬁﬂngs, make the most of it. Don’t copy any
! document that you're sure you'll
ﬁgve: need. If you have a secondary drive
31:1’5 unrelated to the primary drive (that is,

doesn't have any software installed on it
ind will not require reformatting), then you
can leave files there for safekeeping.

You'll want to export your e-mail, as well.
In Outlook, this can be done by opening up
Outlook and right clicking the Outlook
Today icon in the list of mailboxes and
selecting the “Properties for Outlook Today”
option. Then click the Advanced button and
‘copy the path from filename. The path will
lead you directly to the file with all of your
Outlook settings.

If you use a modem, you're going to need
to copy down your ISP’s phone number, as
well as your username and password. This
information can be found in Control
Panel>Network Connections, but your pass-
word will be blotted out, so make sure you
have it written down. Also, you'll need to
record your username and password for any
. kind of broadband, such as PPPOE, that
i
:

rive-imaging software isn't only for
home consumers who want to make
" mirrored copies of their hard drives.
“cloning” is in fact a common proce-

among IT managers who don't want to go
ough the hassle of manually installing a new
0S onabunch of identically configured machines.
- Symantec’s imaging software, Norton
t, has always been a popular choice

requires you to connect
before using. If you use a
static IP address, copy down
all your IP settings, which
can be found by going to
Control Panels > Network
Connections. Right-click
Local Area Connections
and select “Properties.” In
the new menu, highlight
TCP/IP, click the Properties
option and you'll find your
IP info.

Don't forget your saved
games! If you can’t figure out
where they're stored by
browsing game folders, you
can try uninstalling the game.
Before the uninstallation process
begins, many games will offer to
keep the saved game files on your
drive; these files can then be copied
onto your new system when you reinstall
the game. This isn't always going to work,
though, so try first to find the right folder.

“Ablght,mm“paﬂmy
data. I've double-checked that every-
thing else on the drive is expendable.

Yes, I'm sure. I'm ready to move on.

STEP 3

Collect your project tools

It never hurts to double-check your tool box,
because once you get moving, you won't want

e Clone wars

iternatives to Drive Image 2002

among IT bosses because it allows them to
scan networks for machines, then perform
remote imaging on the hapless clones. The
software also has numerous tools for con-
trolling network data transfers.
PowerQuest's Drive Image 2002, how-
ever, is much more friendly toward people
who just want to make images of their hard
drive without mucking around in numerous

STEP 3 The XP CD won't have the most
updated drivers, so download the latest
ones from your vendors’ web sites, and
put them onto a CD.

to be caught empty-handed. So make sure you
have the following.

W Drive Image 2002, the program we'll use
to create the restore disc set.

M Your original Windows XP installation
CD (either Home or Professional).

M At least three CD-Rs or CD-RWs (it
helps to have more on hand in case there
are burning errors or you need more room).

M An optical disc that contains all the

DOS screens. For example, Drive Image 2002
lets you restore your system image from
within Windows, while Norton Ghost
requires you to boot into DOS first. Drive
Image 2002 also has a much better interface
and includes wizards for setup, image cre-
ation, and restoration. While we all have
fond memories of our DOS days, we prefer to
do our work in the comfort of Windows XP.
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drivers you need for your hardware. We sug-
gest that you go onto the Internet and pull
the latest drivers from vendor web sites.
Usually the driver you've got on your CD is
old and moldy, or even Windows
XP-incompatible in some cases.

Try not to forget any components,
because any driver that you don’t update
now will have to be updated every time
you reinstall. So make sure you've got the
most current driver releases for your video-
card, motherboard chipset, soundcard,
network card, USB 2.0 card, printer, and
any specialized A/V cards you might have.
We keep all our drivers on rewriteable
optical discs. This way they all stay in one
place and can be updated as necessary.

We'll warn you ahead of time that
drivers are not always going to be digitally
signed. Digitally unsigned drivers aren’t
necessarily a bad thing as long as the com-
pany has a good reputation for making
stable drivers.

You'll also need the original installation
packages of all of the applications and util-
ities you'll want on your clean system
mirror—Office, Photoshop, ACDSee, what
have you.

Once you have all these parts collected,
you can move on to the next step. )

Vl’lregntnﬁvcbnmzooz,my
Windows XP CD, plenty of CD-Rs, all
the latest drivers for all my hard-
ware, and I know which apps and
utilities I want to install. Now what?

STEP FOUR

Format your drive

This is it: the point of no return. Up until now,
everything we've done has been simple prepa-
ration, but in this step you're going to actu-
ally erase files from your hard drive. If you've
diligently backed up all your data, there's
nothing to worry about.

Here's a final safety tip before we begin:
If you used a removable drive to back up
all your data and it’s still connected to
your PC, disconnect it now. When the XP
install process begins and the formatting
screen pops up, it will display the remov-
able drive as the first partition. Many
unhappy people have inadvertently for-
matted their removable drive—with all
their backed-up data—instead of their
hard drive. Whoops!

Drop the Windows XP CD into your
optical drive and reboot. Since you've

p QT ——

Windows XP Professional Setup

The following list shows the existing partitions

and

unpartitioned space on this computer.

Use the UP and DOUN A
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To create a partition
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STEP 4 Now that you've pooled all your disk space, it’s time to create a partition.

already set it up to be the primary boot
device, you should get a message that says
“press Enter to set up Windows XP."” Do
this. Once you're in Windows Setup, wait
until a “Welcome to Setup” screen appears.
Follow the instructions and press “Enter to
Set Up Windows XP."

When the EULA (end-user license agree-
ment) appears, press F8 to continue. If
Windows is already installed on your hard
drive, then you'll need to press Escape to
bypass the previous install, and install a
fresh copy. Next you should see a list of the
partitions you have on your PC. Before you
do anything, you need to develop a plan for
the final configuration of your partitions.
Partitioning is basically dividing the disk
space of a physical drive among several “vir-
tual” drives called partitions. These virtual
drives show up as separate drives (C, D, E)
within Windows. While many people like to
divide their drives into multiple pieces, we
recommend that you create a single parti-
tion for every physical drive you have.

Remember that there is no helpful
redundancy in creating partitions, because
if a physical drive fails, all of the parti-
tions associated with the drive will die as
well. It is also advantageous to create a
single partition for your OS install because
of the way Windows XP accesses its data.
When a partition spans the entire disk,

Windows XP automatically puts the large
files onto the outside edge of the drive,
where high seek times are mitigated by
high throughput speeds. The smaller,
more frequently accessed files use the
inside edge of the disk platters, to take
advantage of low access times. When you
partition the drive into two pieces, you
lose most of the advantages of this
ordering scheme.

At the partition setup screen, find the
partitions that are associated with your
primary drive (Disk 0). Make sure this is
the drive you want to format. If you have
a physical hard drive that is 120GB, for
example, and another 60GB physical drive
that you backed up your old data on, look
at the format screen and check the disk
size—be absolutely certain that you are
drawing a bead on the right drive. Once
you're certain, delete them by pressing D,
then Enter, then L.

Once this is done, you will have created a
pool of all the free space on your hard drive
and it will be ready for partitioning. Select
the unpartitioned space, press Enter, and
choose “Format the partition using the
NTES file system.” For this task we want to
avoid the Quick option since it simply
rewrites the TOC to make the drive think it's
empty instead of actually erasing anything.
A full format goes through each hard drive



sector and rewrites it, so if you have a bad
sector on your drive, it will be exposed now
rather than later.

Now let the drive format. This will take a
long time.

‘/weﬁm-mamymmdmy
avoided disaster. Windows XP is now
mdymimmlﬂmdf No sweat.

STEP 5

Install Windows XP

After the format of your hard drive, your PC
will reboot, and the Windows XP install rou-
tine will swing into action. You'll be prompted
along the way for basic information, and asked
to enter your Product Key.

After Windows XP asks for your desired
network setup option for broadband and
modem connections, the rest of the installa-
tion will progress automatically. When it has
finished and rebooted, you'll be prompted
to change your display resolution. Follow
the onscreen instructions and allow
Windows to boot into the familiar desktop.
You'll also receive a message asking if you
want to register and activate Windows.
(Note that activation is required, but regis-
tration is not.) If Windows was able to recog-
nize your network card and you use a broad-
band connection, then you can probably
activate now. Otherwise, you'll have to wait
until after you have installed the network
card or modem drivers (see the next step).

Vomaoke, a fresh copy of
Windows is now completely installed.
What do I do next?

STEP 6

Run Windows Update

An exciting new ook
Windows® XP Professional sports a brand-new visual design

The redesigned Start menu makes it easier to find important
nmwmmmhmmmmm

By automatically cleaning up the notification area of the
taskbar and grouping related taskbar tems, Windows XP

Qur first stop after installing Windows XP is
Windows Update, Microsoft’s one-stop online
shop for security fixes, OS updates, and certi-
fied drivers.

If you're using a network card and you
connect through a standard DHCP broad-
band connection, then you can skip to the
next part about running Windows Update.
But if you're using a modem, or if you need
to install specialized network parameters
(username and password) from your broad-
band ISP to connect to the Internet, then
we'll need to visit the Control Panel before
going to Windows Update.
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makes it easier to switch between programs and to op
view, or cdose mudtiple items at the same time, 2

STEP 5 Installing XP is easy, just follow the directions onscreen.

Go to the Start Menu and click Control
Panel. On the left-hand side there should be

an option that says “Switch to Classic View.”

Click this and you'll see the familiar set of
Control Panel icons. Double-click Network
Connections, and on the sidebar choose
“Create a New Connection,” choose the
“Connect to the Internet” option, then “Set
Up My Connection Manually.” From here
you can choose to connect through dialup
or broadband with a username and pass-
word. Go through the desired menu selec-

2 Microsofll Windows Update - Microsofi Internel Explarer

Tatal Selected Updates
Review and install your selected updates.
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tion and enter the information that you've
copied down or that your ISP has supplied
you with. After you're done, try to achieve a
connection with your ISP. If you use a static
IP, make sure you select that option in the
Network Connection Wizard.

Once you're able to log on and access
the Internet, go to the Start Menu on the
Taskbar, select All Programs and click
Windows Update. This will open an Internet
Explorer browser that will automatically con-
nect you to the Windows Update site. Once
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STEP 6 You'll need to go to Windows Update often—your OS is a work in progress. ‘
|
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Please select the required setup type:

CREATIVE

STEP 7

Install drivers

As we discussed earlier, having the latest drivers
is extremely important to a well-functioning
machine, but you'll want to be careful with
some of the stuff you put on your freshly
installed OS.

Vendor driver discs tend to contain tons
of extras that most people neither need nor
want. Creative Labs, for example, packs a
dozen or so programs with its Sound Blaster
Audigy driver CD, and it all installs by
default. So when installing from vendor
driver packs, make sure you always select the
minimum possible installation without all
the extraneous software that'’s just going to
muck up your pristine box. You can always
add craplets later if you feel like you're
missing out on something.

Most people use videocards based on
either nVidia or ATI chipsets. Although
your board maker may have a specialized
driver pack, it’s usually little more than a
reference driver with a bunch of extra crap

Full Installation:
‘When you want to create and experie
multimedia contents.

Custom Installation:
For advanced users. You can choose
individual components.

Drivers Only:
Only drivers are installed.

STEP 7 Whenever possible, select the leanest driver installation option—you can

always add programs later.

the page comes up, click the “Scan for
Updates” option and wait while your com-
puter is gently probed.

Once your computer is checked, you'll
have three different categories of updates
available to you. The first section is Critical
Updates, which will automatically be
selected for download. You can click on
that section to review what is going to be
installed, but it's best to just leave it alone
and let Windows Update patch whatever
security holes the hacking gurus have come
up with this week.

The second section is Windows XP and
it contains noncritical software updates for
Windows. We recommend installing every-
thing you think you'll need, especially the
Microsoft Virtual Machine and all the rec-
ommended updates.

The last section is Driver Updates, and
it contains a sparse list of WHQL certified
drivers for yvour hardware. These drivers will
usually be a bit older than the latest ones
you can find on your vendors’ web sites. You
may want to go with the latest update, even
if it isn’t sanctioned by Microsoft.

“l’vegnnc to Windows Update and
brought my OS up to date. Are we
done yet?

AUGUST 2002

tacked on. To avoid this, just download

the latest reference driver from either
www.nvidia.com or www.ati.com. nVidia
makes this especially easy by providing a

Advanced
Remote

Computer Name = Hardware_
Automatic Updates

General
System Restore

;“

Notification Settings

7=, Download the updates automatically and notify me when they are
“~ ready to be installed.

How do you want to be notified when updates are available for
your computer?

~~ Motify me before downloading any updates and notify me again
" before installing them on my computer.

~ Tum off automatic updating. | want to update my computer
“~ manually.

Previous Updates

STEP 8 Take the time to customize your settings. This includes folder views, update

notification, and display properties, among other things.




unified driver that will work on any of its

video chipsets since the TNT2.

Your motherboard chipset will probably

STEP 8

Tweak WinXP

be based on either an Intel or VIA chipset,

although it may also be one from SiS, ALi,
nVidia, or AMD. Check the vendor’s web
page for the latest driver updates. Having
the latest chipset driver is far more impor-

tant then most people think.

These days, most everyone runs a sound-
card from Creative Labs, although there are
some other vendors still out there, as well
as a ton of integrated audio chips. For inte-
grated audio, check your motherboard
vendor’s web site and you should be able to
find what you need. Audio card drivers are
usually available as downloads from the

vendor’s home page.

Once you're done installing drivers,
reboot your PC and go on to the next step.

Display Properties

].

Themes Desktop Screen Saver Appearance Settings

Display:

Hitachi CM751 on NVIDIA GeForced Ti 4600

Screen resolution

Less

v

1024 by 768 pixels

More

This is the final step in your OS installation.
Here’s where you turn Microsoft’s Windows
XP into your XP by customizing its configura-
tion and tweaking the settings for maximum
performance.

If you didn’t activate Windows during
setup, do that first by clicking the key icon in
your System Tray. Windows will generously
offer to take you on a tour, install a Passport
account, etc. Click all these reminders, then
cancel them right away if you're not inter-
ested. This will prevent you from being
bugged about them every time you reinstall.

Change the display resolution if you
haven't already. In fact, while you're in
Display Properties, take the time to set
your power-management settings and
Windows décor.

Set up directories for your personal data
within My Documents, so you'll have a
fairly easy method of backing it up later.
Tweak My Documents to reflect the view
you prefer (we prefer to see file details, not
icons, so go to the View menu and select
Details). If you want, you can go to Tools >
Folder Options, select the View tab, and

o5

Notification area

Color quality
Highest (32 bit)

v

[ Troubleshoot.. | [ Advanced |

0K || Cancal |

Taskbar  Start Menu

Taskbar appeatance

Lock the taskbar

[¥] Auto-hide the taskbar

[¥] Keep the taskbar on top of other windows
Group similar taskbar buttons

[] Show Quick Launch

[¥] Show the clock
‘You can keep the notification area uncluttered by hiding icons that you

apply these settings to all your folders by
clicking “Apply to all folders.”

Next, right-click the My Computer icon
on the desktop and select Properties. When
the Properties window opens, select the
System Restore tab and adjust the slider to
the amount of disk space you want to allo-
cate to System Restore. Also make sure you
examine the “Automatic Updates” and
“Advanced” tabs in order to set preferences
for Users, Windows Update, Performance,
and Startup. Don’t forget to go into Internet
Explorer and specify your security settings (at
Tools > Internet Options > Security). If you
plan on using a software firewall, you can
configure that now as well.

If you prefer a more comprehensive, one-
stop approach, check out programs such as
TweakXP (included on this month'’s disc) that
provide easy access to all the Windows XP’
tweaking options within one application.

Mm,mmxrunmmm
tastes. No, I mean it. I've scrubbed
through every dialog box and tab,

Explorer, to reflect my preferences.
Let's carry on.

Taskbar and Start Menu Properties

have not clicked recently.
[¥] Hide inactive icons

Lok JI | Aoy

STEP 8 Don't forget your display settings. STEP 8 And always customize your Start Menu.
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Install your applications

The final step in building your custom OS
image is to install all the key applications
you want loaded whenever you do a clean-
start reinstall. These apps should be installed
judiciously, so wherever possible, select
“custom” installations and limit the mod-
ules and install packages to just the ones you
know you'll want to use.

Avoid installing programs that are fre-
quently updated. For example, we’re per-
fectly happy with Office 2000 and don’t
have any plans to upgrade to Office XP, so
we're going to add Office 2000 to our base
install. But with something like an instant-
messaging client, which is updated almost
obsessively, we prefer to install the latest
version each time we go for a clean start.

Before you move on to the next step,
make sure you try running all your pro-
grams at least once to ensure that the
installs were successful.

%’wﬁnﬁﬂdaﬂﬁeappﬁmﬂmm
that I want on my pristine system
image. And, yes, I've ensured the
installations are as minimal as pos-
sible, selecting only the modules that
I'll actually use.

STEP 10

Create Restore Discs

You've gone through a long and tedious process
to get here, but remember, you won't have to
do it again for a long time. In this step, you're
going to create the restore discs that will allow
you to effortlessly refresh your system when-
ever you want.

Insert the Drive Image 2002 CD into your
drive, and run the setup program. Enter
your username and serial number, and press
Continue. When vou come to the Install
Customization screen, use the defaults
unless you plan to back up using a Zip/Jaz
drive or SCSI CD burner.

When asked if you want to create rescue
discs, make sure you have two floppies
ready to go. These discs will help you re-
image your hard drive even if you can't
boot into Windows.

After you create the rescue discs, label
them and open Drive Image 2002. When
the wizard selection menu comes up,
check the box next to “Initial Backup
Wizard” to continue with the default
imaging process. Unless you want to
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STEP 9 Feel free to install Office, but leave the more commonly updated programs

until later.

modify the compression setting or tweak
the amount of space that the images use
on each CD, it's best to stick with the
defaults. Compression is automatically set
to high, which takes up less space but takes
longer to compress when creating the
image. It really doesn’t make any sense at
all to use no compression as it takes just a
few extra minutes to make the initial
images, and compressed images write back
to the hard drive much, much faster than
uncompressed images.

At the next screen, put a check mark next
to your primary drive and insert a blank CD
into your burner. When that’s done, click
Next, pick your burner from the list, and
click Finish. Make sure all your programs are
closed, then press the Yes button to restart
the machine and begin the process. Your
drive will now be compressed and written to
disc. Follow the onscreen instructions to exit
the program. Don't forget to label the discs
consecutively when you're done. Well, golly,
you've done it. You've made a complete
image of a pristine system. Now, whenever
you want a clean start, you can use one of
the following methods to restore your
system to its original state. Rernember that
these processes will wipe out all your personal files,
so make absolutely sure you repeat step two and
back up all your data.

RESTORING FROM WINDOWS (EASIEST AND
BEST) If you want to re-image your drive
and can still boot into your old install, the
process is an absolute snap. Just open up

Drive Image within Windows and cancel
past the welcome screen. Insert disc one
of your backup discs into the CD drive
and click the Restore Image option. Click
“Select Image File” and point it to the .pqgi
file on disc one. Drive Image will ask you to
insert disc two, then disc one again—just
follow the directions. Once that’s done,
click Finish, and insert the discs as
requested by Drive Image.

RESTORING FROM CD If your PC just won't boot
into Windows and you're loathe to use your set
of floppies (if you even made them), then you
can boot directly off the Drive Image CD itself,
The CD will drop you onto the command line.
When you see the A:\> on your screen type:
¥:\english\execute\pqgdi.exe then press
the Enter key.

After the interface comes up, click the icon
for Restore Image, then point it to disc one
(which you should place in your drive now).
Then just follow the instructions.

In case you were wondering, it's possible
to make bootable CDs for your restore discs.
But since you need the Drive Image program
to restore the image anyway, why not just
boot from its CD?

RESTORING FROM FLOPPY DISK This is the
same procedure as booting from CD, except
that you will not need to enter DOS. Pop in
the first of two floppies you made when you
installed Drive Image and reboot. Drive Image
will ask for the second floppy, and start up its
GUI automatically.
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STEP 10 Select the image file you would like restored (you can have as many archived

images as your drive can hold), and click Finish. Drive Image will take the reins from there.

Keeping your Windows clean

While even the most diligent housekeeper will
find it impossible to keep a system absolutely
free of data dust, there are still many ways to
put off spring cleaning for up to six months or
more, depending on your usage and degree of
slovenliness. Your first defense is simple common
sense. Be judicious and selective about software

espite Microsoft's best efforts to
bury the legacy of the command
{ line, there are still times when
you might need to go old-school and
create a DOS boot disk. For instance, if
your motherboard doesn't support booting
n the CD-ROM and you have no inten-
on of upgrading.
Windows XP does allow you to
a rudimentary MS-DOS boot disk
ht-click your floppy drive, select

it, and check the option to add
files). But you won't have any
M drivers on the disk, nor any of
might need like FDISK,

installation packages, customizing their installs
wherever possible. Avoid installing programs
that have extensive spyware—and that means
most file-sharing P2P applications (unless you
can find one of the unauthorized, ad-free “lite”

use (and update frequently) Lavasoft's Ad-
aware (www.lavasoft.nu) to get rid of com-
mercial garbage dumped into your Registry
and system folders.

You can also avoid strangling the pipes
with cross-linked files and file fragments
by shutting down Windows the right way.
Use the Start Menu > Turn Off the
Computer selection. Shutting down by
simply flipping off the power switch can
lead to data loss, file corruption, and the
little droppings mentioned above. Trust us,
take the extra five seconds and shut down
the right way.

Virus checks and regular defragmenta-
tion of your hard disk are also essential to
keeping your PC in top shape. System main-
tenance packages like Norton Utilities 2002
contain numerous tools for Registry
cleaning, disk defragmenting, virus
checking, and removing old files and short-
cuts. Likewise, McAfee's QuickClean (avail-
able for Windows 95b through XP) is a
stand-alone utility that blows out the
garbage from all of Windows’ hiding places,
deletes duplicate files and orphaned short-
cuts, and safely “shreds” these files on their
way out. And the next time you get a mes-
sage saying that the uninstall is completed
but “some elements could not be removed,”

versions online).

Even if you don’t use any of the tradi-
tionally suspect software, you should still

Tricky Disk

- Booting the Old-Fashioned Way

Format, and even Edit. The best solution
is to whip up your own custom all-pur-
pose boot disk.

There's no need to reinvent the
wheel, though—most of the dirty work
has been done for you. Go to
www.drd.dyndns.org and click the “Boot
Disks” link. Scroll to the bottom where
you'll find “Boot Disk Essentials” and
click the download link (the red floppy
icon). Then click on “whootess.exe” to
download it to your hard drive.

After it has completed downloading,
put a disk into your floppy drive and
launch the whootess executable. Click

QuickClean steps in and removes them for
you. At this point, we think that's some-
thing everyone can appreciate. ll

OK, and the program will create a boot
disk for you, similar to the Windows 98
boot disk, but with a greater assortment
of standard tools. You will get a univer-
sal CD-ROM driver, a mouse driver, a
copy of FDISK and more.

If you want more information on
creating boot disks, or if you want to
tailor your own custom boot disk, go
to www.bootdisk.com. You can also
download other users’ custom disks
for your own use. But be aware that
you must possess a valid license of
Windows before downloading a boot
disk imaging program.
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